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Abstract
Forests in Indonesia must be managed continuously in order to provide benefits to the Indonesian people. One 

of the government's efforts is to give trust to forest edge communities to manage and take benefits according to 
their needs and abilities through the Community Forest (HKm) program. Karang Sidemen Village has run the HKm 
program and is managed by the HKm Farmers Group Association (Gapoktan) of Karang Sidemen Village (Wana 
Lestari). In 2019, HKm Wana Lestari had an analog-based map of arable land. Meanwhile, in 2021, HKm Wana Lestari 
needs a detailed technology-based map. This study aims to build a Geographic Information System that can display 
detailed maps of Gapoktan members of Wana Lestari. This system is built based on mobile with Extreme 
Programming method and integrates Google Maps API. The User Acceptance Test (UAT) method is used to test 
system features and the Guttman scaling method is used to draw system conclusions. The scalability coefficient value 
generated in the Gapoktan Chairman feature test is worth 1, the Gapoktan Member feature is worth 0.82, the Village 
Head feature is worth 1, and the FMU Head feature is worth 1 so it has a good conclusion. 

 
Keywords: Geographic Information System, Community Forest, Extreme Programming, Google Maps API, User 
Acceptance Test. 
 

 

1. PENDAHULUAN 

Hutan adalah sumber daya alam yang sangat 
penting. Hutan di Indonesia harus dikelola secara terus 
menerus agar dapat memberikan manfaat kepada 
rakyat Indonesia[1]. Salah satu upaya pemerintah 
untuk menggapai tujuan tersebut yaitu memberikan 
kepercayaan kepada masyarakat yang tinggal di 
pinggiran hutan untuk mengelola hutan negara sesuai 
dengan kebutuhan dan kemampuannya dan tetap 
menjaga kelestarian hutan dengan program Hutan 
Kemasyarakatan (HKm). 

Hutan Kemasyarakatan adalah hutan milik negara 
yang bertujuan untuk memberikan manfaat dan 
menyejahterakan masyarakat setempat sesuai dengan 
isi yang terkandung pada Peraturan Menteri Kehutanan 
Republik Indonesia Nomor P.88/Menhut-II/2014 
tentang Hutan Kemasyarakatan[2]. 

Nusa Tenggara Barat mendapatkan bagian areal 
kerja HKm seluas 14.836,50 hektar dan terdapat di 8 
Kabupaten/Kota seluruh provinsi. Daerah Batukliang 

Utara mendapatkan areal kerja HKm seluas 1.809,5 
hektar dan tersebar pada 4 desa, antara lain Lantan, 
Karang Sidemen, Aik Berik, dan Setiling[3].  

Desa Karang Sidemen merupakan salah satu desa 
yang telah menjalankan program HKm dan dikelola 
oleh Gabungan Kelompok Tani (Gapoktan) HKm Desa 
Karang Sidemen (Wana Lestari) sesuai dengan 
Keputusan Bupati Lombok Tengah Nomor 39 Tahun 
2010 tentang Izin Usaha Pemanfaatan Hutan 
Kemasyarakatan (IUPHKm). Berdasarkan Keputusan 
Bupati tersebut, Gapoktan HKm Desa Karang Sidemen 
(Gapoktan Wana Lestari) mendapatkan IUPHKm 
dengan Nomor Blok Izin II, Luas Lahan Garapan 403 Ha, 
dan Jumlah Anggota 741 orang. Salah satu yang wajib 
dilakukan oleh petani yang memegang izin usaha yaitu 
melakukan penataan batas areal kerja. Berdasarkan 
hasil wawancara, pada tahun 2019 HKm Desa Karang 
Sidemen telah memiliki peta lokasi garapan yang dibuat 
berdasarkan blok-blok yang dikelola oleh 17 kelompok 
tani yang tergabung dalam Gapoktan Wana Lestari dan 
berbasis kertas/file jpg. Sedangkan kebutuhan pada 
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tahun 2021 adalah adanya peta lahan garapan masing-
masing anggota berbasis teknologi yang 
menggambarkan lokasi dan luas lahan garapan. Peta 
lahan garapan masing-masing anggota akan dikemas 
dalam sebuah sistem informasi berbasis mobile dan 
bersifat online karena sebagian besar anggota HKm 
Desa Karang Sidemen telah menggunakan perangkat 
mobile dan jaringan internet. 

 
Gambar 1. 1 Peta HKm Desa Karang Sidemen 

Sistem Informasi Geografis merupakan sistem atau 
aplikasi yang berfungsi untuk membantu mengerjakan 
pengolahan dan penyimpanan data geografis[4]. ArcGis 
merupakan salah satu sistem informasi atau aplikasi 
yang banyak digunakan untuk menolah data 
geografis[5]. 

Extreme Programming merupakan metode 
pengembangan software yang menyederhanakan 
berbagai tahapan menjadi lebih efisien, adaptif dan 
fleksibel[6]. 

Berlandaskan kebutuhan HKm Desa Karang 
Sidemen, maka penulis bertujuan untuk membuat peta 
HKm berbasis teknologi yang akan dikemas dalam SIG 
berbasis mobile yang bermanfaat untuk pemegang izin 
usaha pemanfaatan HKm, Pemerintah Desa Karang 
Sidemen, dan Kesatuan Pengelolaan Hutan (KPH) 
Pelangan Tastura. 

 

2. TINJAUAN PUSTAKA 
 

2.1. Penelitian terkait 
Pada proses penelitian, Rancang Bangun Sistem 

Informasi Geografis Pemetaan Lahan Garapan 
Kelompok Tani Pada Hutan Kemasyarakatan Desa 
Karang Sidemen Berbasis Mobile ini tetap mengacu 
pada penelitian sebelumnya. Penelitian tersebut 
digunakan untuk dijadikan referensi pada 
pengembangan sistem informasi ini. 

Sistem informasi dengan judul “Aplikasi Sistem 
Informasi Geografis dalam Penilaian Proporsi Luas Laut 

Indonesia” dimana penelitian ini menggunakan 
teknologi sistem informasi geografis yang bertujuan 
untuk memperoleh dan menyebarkan data terbaru 
tentang angka proporsi laut Indonesia[7]. Pada 
penelitian ini menggunakan data geografis provinsi 
seluruh Indonesia yang dijadikan landasan perhitungan 
luas daratan dan data Wilayah Pengelolaan Perikanan 
Republik Indonesia yang dijadikan dasar perhitungan 
luas laut Indonesia. Kedua data tersebut menggunakan 
sistem koordinat geografis yang memiliki lintang dan 
bujur. 

Penelitian dengan judul “Pembuatan Peta 
Digital Topografi Pulau Panjang, Banten, 
Menggunakan ArcGIS 9.2 dan SURFER 8” yang 
bertujuan untuk mendukung kegiatan studi kelayakan 
calon tapak Pembangkit Listrik Tenaga Nuklir (PLTN) di 
Indonesia. Penelitian ini menggunakan data raster 
yang diperoleh dari google map dan masih berbentuk 
peta analog atau berformat JPEG. Data raster tersebut 
kemudian dikonversi menjadi peta digital berformat 
SHP melalui proses rektifikasi, digitasi, overlay, adding 
coordinate, menggunakan aplikasi ArcGis 9.2. 
Pembuatan kontur dan layout menggunakan aplikasi 
SURFER 8[8]. 

Penelitian dengan judul “Penerapan Sistem 
Informasi Geografis Dalam Pemetaan Produksi 
Pertanian di Kabupaten Bone” yang bertujuan sebagai 
sumber acuan pemerintah Bone dalam mengambil 
keputusan terhadap upaya meningkatkan hasil 
pertanian pada tahun selanjutnya. Pada penelitian ini, 
metode Extreme Programming dipakai untuk 
mengatasi permintaan client yang tidak jelas dan 
sering berubah (vague and volatile requirements)[9]. 

Penelitian dengan judul “Penerapan Metode 
Haversine Formula Pada Sistem Informasi Geografis 
Pengukuran Luas Tanah” yang bertujuan untuk 
membantu pegawai Badan Pertanahan Negara (BPN) 
untuk mengukur luas tanah dan menyimpan informasi 
luas tanah yang telah diukur. Penelitian ini 
menggunakan metode Haversine Formula untuk 
menghitung jarak antar 2 titik dengan tetap 
mempertimbangkan bahwa bumi merupakan sebuah 
bidang yang mempunyai derajat kelengkungan[10]. 
Pada penelitian ini terdapat perbedaan hasil 
perhitungan sistem, GPS, dan kenyataan. 
Selisih luas tanah menggunakan metode Haversine 
Formula dengan kenyataan sebesar 7.33%. Untuk total 
selisih kenyataan dengan GPS sebesar 2 meter. 

Penelitian dengan Judul “Penerapan Agyle 
Methodology Dalam Pengembangan Sistem Informasi 
Geografis Pemetaan Daerah Pertambangan” yang 
berguna untuk memudahkan proses pencatatan dan 
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manajemen data pertambangan di Indonesia. 
Penerapan Agile Methodology digunakan pada saat 
pengembangan karena sebuah agile process harus 
beradaptasi dengan perubahan[11]. Penelitian ini 
menggunakan data pertambangan dan peta Provinsi 
Jawa Timur. 

Berdasarkan referensi di atas tersebut, diketahui 
bahwa dari beberapa penelitian yang membuat SIG 
pemetaan lahan/lokasi hanya menggunakan data dari 
tahun-tahun sebelumnya. Pada Tugas Akhir ini akan 
dibangun SIG pemetaan lahan/lokasi yang akan 
menggunakan data asli dan terbaru yang diukur 
langsung menggunakan bantuan alat Global Positioning 
System (GPS), kemudian dikelola menggunakan 
software ArcGIS. 
2.2. Teori penunjang 
2.2.1. Sistem Informasi Geografis 

Sistem Informasi Geografis (SIG) adalah aplikasi 
atau tools yang dibuat untuk pengolahan seluruh jenis 
data geografis[12]. 
2.2.2. Hutan Kemasyarakatan 

Hutan Kemasyarakatan merupakan hutan 
negara yang bertujuan untuk memberikan manfaat dan 
menyejahterakan masyarakat setempat sesuai dengan 
isi yang terkandung pada Peraturan Menteri Kehutanan 
Republik Indonesia Nomor P.88/Menhut-II/2014 
tentang Hutan Kemasyarakatan[2]. 
2.2.3. Skala Guttman 

Skala Guttman merupakan metode 
perhitungan yang menghitung dua pilihan jawaban, 
misalnya ya atau tidak, baik atau jelek, berhasil atau 
gagal, dan lain-lain. Jadi, data yang diperoleh bernilai 
Boolean (positif = 1 dan negative = 0 )[19]. 

Koefisien reprodusibilitas berfungsi untuk 
menghitung ketepatan alat ukur (misalnya daftar 
pertanyaan kuesioner) dan dihitung menggunakan 
rumus menurut: (Nasir, 1998) 

𝐾𝑟 = 1 −
𝑒

𝑛
 (1) 

Keterangan: 
n = Total kemungkinan jawaban (total pertanyaan x 
total responden) 
e = Total error 
Kr = Koefisien Reprodusibilitas  
Setelah mendapatkan nilai Kr, maka dihitung nilai 
koefisien skalabilitas dengan rumus: 

𝐾𝑠 = 1 −
𝑒

𝑝
 (2) 

 
Keterangan: 
e = Total error 
p = Total kesalahan yang diharapkan, yaitu 0.5 x ((total 
pertanyaan x total responden) – total jawaban “YA”)  

Ks = Koefisien Skalabilitas 
Dari hasil perhitungan koefisien skalabilitas, jika skala 
nilai Ks > 0.6 maka sudah dianggap baik[20]. 
 

3. METODOLOGI PENELITIAN 
 
3.1. Alat dan bahan 
3.1.1. Alat 

Alat-alat berupa software maupun hardware 
yang digunakan pada pembuatan SIG pemetaan lahan 
garapan kelompok tani pada HKm Desa Karang 
Sidemen, antara lain: 
1. Laptop Asus Intel (R) Core (TM) i5-7200U CPU @ 

2.50GHz   2.71 GHz 
2. Sistem Operasi Windows 10 Pro 
3. Smartphone Samsung Galaxy A50 RAM 6 GB ROM 

128 GB 
4. Sistem Operasi Android 10 
5. Android Studio 
6. ArcGIS versi 10.8 
7. Firebase Realtime Database 
8. GPS 
9. Google Maps API 
3.1.2. Bahan  

Penelitian ini menggunakan bahan yang diambil 
dari literatur-literatur jurnal penelitian sebelumnya 
maupun buku yang berkaitan. Selain itu, diperoleh juga 
data-data pendukung lainnya berupa: 
1. Data Izin Usaha Pemanfaatan HKm yang 

dikeluarkan oleh Bupati Lombok Tengah dengan 
Nomor 39 Tahun 2010 kepada Gapoktan HKm 
Desa Karang Sidemen yang meliputi: 
a. Luas lahan HKm beserta nomor blok yang 

diizinkan untuk dikelola oleh Gapoktan HKm 
Desa Karang Sidemen.  

b. Data diri anggota setiap kelompok yang 
tergabung di Gapoktan HKm Desa Karang 
Sidemen serta Luas lahan garapan setiap 
anggota kelompok. 

c. Lokasi lahan garapan setiap anggota 
kelompok. 

d. Data hasil wawancara dengan ketua Gapoktan 
HKm Desa Karang Sidemen dan Kepala KPH 
Pelangan Tastura. 

3.2. Alur penelitian 

 
Gambar 3. 1 Flowchart alur penelitian 
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3.2.1. Studi literatur 
Studi literatur merupakan metode pengumpulan 

informasi yang memiliki keterkaitan dengan penelitian 
melalui jurnal, buku, artikel ilmiah, maupun situs-situs 
internet. Selain dari sumber yang telah disebutkan, 
penulis juga mengumpulkan informasi melalui 
wawancara, diskusi, dan observasi ke lokasi penelitian. 
3.2.2. Wawancara 

Wawancara dilakukan kepada Ketua Gapoktan 
HKm Desa Karang Sidemen (Wana Lestari), anggota, 
Kepala KPH Pelangan Tastura dan pemerintah 
setempat. Beberapa pertanyaan yang diajukan 
berkaitan dengan apakah aplikasi ini dapat 
memecahkan permasalahan yang ada, apakah aplikasi 
ini dapat memudahkan instansi maupun Gapoktan 
Wana Lestari mengetahui lokasi dan luas tanah yang 
digarap oleh setiap anggota, dan saran fitur pada 
aplikasi. 
3.2.3. Perhitungan luas lahan 

Pada tahapan ini dilakukan perhitungan lahan 
garapan masing-masing anggota untuk mendapatkan 
luas lahan, batas masing-masing lahan, lokasi lahan, 
garis lintang, dan garing bujur yang akan dihitung 
menggunakan bantuan alat Global Positioning System 
(GPS). Pada perhitungan lahan ini akan dibantu 
langsung oleh Tim KPH Pelangan Tastura dan Petani 
dari Gapoktan Wana Lestari. 

Langkah pertama yang dilakukan ketika 
pembuatan peta yaitu mengukur lahan menggunakan 
GPS. Pilih menu jejak pada GPS kemudian jalan 
mengelilingi lahan garapan petani dan berhenti pada 
titik awal kemudian simpan data. Langkah ini dilakukan 
berulang-ulang sebanyak lahan petani. Namun pada 
saat pengukuran lahan, banyak kendala yang dihadapi 
seperti jurang, semak-semak berduri, kayu tumbang 
menghalangi jalan, sarang hewan berbahaya (ular, 
kalajengking, dll), dan masih banyak lagi sehingga tidak 
dilakukan pengukuran melalui batas lahan yang 
berbahaya tersebut dan menjadi data yang tidak sesuai 
dengan kenyataan. Kendala-kendala yang dihadapi 
nantinya dicatat dan diperbaiki menggunakan software 
ArcGis. 

 
3.2.4. Mengumpulkan data tumbuhan 

Setelah setiap lahan petani diukur, kemudian 
dilakukan wawancara mengenai tumbuhan yang ada 
pada lahan petani. Adapun data yang dikumpulkan 
meliputi kayu dan Hasil Hutan Bukan Kayu produktif 
dan nonproduktif yang ditulis pada tally sheet atau 
lembaran perhitungan data yang telah disiapkan 

 
 

3.2.5. Pembuatan peta 
Setelah semua lahan petani diukur, selanjutnya 

langkah selanjutnya yaitu memindahkan data lahan 
dari GPS ke komputer/laptop. Pemindahan data 
dilakukan menggunakan aplikasi DNR GPS dengan 
Datum WGS 1984 dan UTM Zona 50S (Zona Wilayah 
Nusa Tenggara Barat). Kemudian cari file data lahan 
yang diperoleh dari GPS dengan ekstensi file GPX (.gpx) 
dan download data waypoint ke komputer/laptop 
dengan ekstensi file ESRI Shapefile 3D (.shp). 

 
Gambar 4. 1 Zona Universal Transverse Mercator 

(UTM) Indonesia 

Setelah data point (titik) jejak yang diperoleh 
menjadi shapefile (.shp), langkah selanjutnya yaitu 
membuat peta menggunakan software ArcGis 10.8. 
Langkah-langkah pada ArcGis sebagai berikut. 
1. Tambah data yang berekstensi shapefile (.shp) 

dengan cara menekan tombol File > Add Data > Add 
Data > Pilih file yang akan dibuka > Add. 

 
Gambar 4. 2 Langkah tambah shapefile ke ArcGis 

2. Edit data titik dan perbaiki agar sesuai dengan 
kenyataan. 

 
Gambar 4. 3 Data point (titik) lahan 
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3. Membuat data polygon atau area dengan 
menyambungkan titik satu dengan yang lainnya 
sesuai dengan titik lahan masing-masing. 

 
Gambar 4. 4 Membuat poligon (area) lahan 

4. Setelah polygon semua lahan jadi, selanjutnya yaitu 
mengekspor data koordinat ke dalam bentuk excel 
(.xlsx) yang berisikan data nama petani pemilik 
lahan, latitude batas, longitude batas, latitude titik 
tengah, dan longitude titik tengah. 

 
Gambar 4. 5 Data koordinat lahan 

 
3.2.6. Mengkonversi data koordinat ke sistem 

Setelah pembuatan peta pada software ArcGis 
dilakukan, berikut langkah-langkah mengkonversi data 
koordinat tersebut ke dalam SIG yang dibangun. 
1. Data koordinat (latitude dan longitude) setiap 

anggota yang terdapat pada file excel kemudian di-
input ke database oleh admin menggunakan SIG 
yang telah dibangun pada menu tambah koordinat. 

2. Pada halaman peta, sistem melakukan import 
google maps API agar SIG yang dibangun dapat 
menggunakan semua fitur google maps, salah 
satunya adalah fitur pembuatan polygon yang 
menggambarkan lahan setiap anggota. 

3. Kemudian SIG mengambil data koordinat ke 
database firebase dan disimpan ke dalam sebuah 
array list dengan tipe data double untuk setiap 
anggota. 

4. Setelah semua data koordinat tersimpan pada array 
list, kemudian SIG mengkonversi data tersebut 
menjadi polygon menggunakan fitur dari google 
maps API. 
 

3.2.7. Perencanaan sistem 
Perencanaan dilakukan bertujuan agar penulis 

dapat mengetahui kebutuhan yang diperlukan dalam 

perancangan sistem. Pada tahapan ini dilakukan 
identifikasi kebutuhan sistem beserta analisisnya. 
Begitu pula kebutuhan pengguna sistem[23].  

Data yang dibutuhkan pada penelitian ini, 
diantaranya data diri Anggota Gapoktan, data luas 
lahan garapan anggota, batas-batas lahan anggota, dan 
lokasi lahan garapan. Kemudian setelah dilakukan 
wawancara dan diskusi bersama Ketua Gapoktan, 
Anggota, Kepala KPH Pelangan Tastura, dan Kepala 
Desa Karang Sidemen, penulis menggambarkan 
kebutuhan-kebutuhan pengguna dalam tabel user 
stories. 

 
Tabel 3. 1 User Stories 

Pengguna Kebutuhan Sistem 

Ketua 
Gapoktan 

Ketua Gapoktan memiliki akses untuk 
melihat, menambah, mengedit, dan 
menghapus data. Adapun data-data 
yang dimaksud yaitu data anggota, 
Kepala Desa, Kepala KPH, dan lahan 
petani. Untuk mengakses semua fitur, 
Ketua Gapoktan harus login ke sistem 
menggunakan id Ketua Gapoktan dan 
password. 

Anggota 
Gapoktan 

Anggota Gapoktan memiliki akses 
untuk melihat, menambah, mengedit, 
dan menghapus data jenis dan jumlah 
pohon pada lahan pribadi. Selain itu, 
Anggota Gapoktan juga dapat melihat 
peta lahan, data anggota beserta data 
lahan dan pohon. Untuk mengakses 
semua fitur, Anggota Gapoktan harus 
login ke sistem menggunakan id 
Anggota Gapoktan dan password. 

Kepala 
Desa 

Kepala Desa memiliki akses untuk 
melihat peta lahan, data anggota, dan 
data Kepala KPH setelah melakukan 
login ke sistem menggunakan id Kepala 
Desa dan password. 

Kepala 
KPH 

Kepala KPH desa memiliki akses untuk 
melihat peta lahan, data anggota, dan 
data Kepala Desa setelah melakukan 
login ke sistem menggunakan id Kepala 
KPH dan password. 

Setelah mendapatkan kebutuhan-kebutuhan 
maka dilanjutkan ke tahap iteration planning dimana 
tim XP membangun software menggunakan iterasi dua 
minggu yang digambarkan pada tabel iteration 
planning berikut.  
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Tabel 3. 2 Iteration Planning 

Iterasi 
Ke- 

Target Fitur 

I Membangun fitur peta/lahan 

II Membangun fitur Ketua Gapoktan 

III Membangun fitur Anggota Gapoktan 

IV 
Membangun fitur pohon, Kepala Desa, 
Kepala KPH 

Pada tahapan ini juga dibangun sebuah 
acceptance test criteria. Acceptance test dilakukan oleh 
end-user atau pengguna dari sistem yang berfokus 
pada fitur dan fungsional sistem secara menyeluruh. 
3.2.8. Design 

Pada tahapan ini dibuat rancangan CRC-Card yang 
berfungsi untuk merancang kelas-kelas pada sistem. 
Desain sistem ini tetap didasarkan pada user stories 
dan dilakukan menggunakan pendekatan berorientasi 
objek yaitu Unidentified Modelling Language (UML). 
1. Class Responsibility Collaboration Card (CRC-

Card) 
Tabel 3. 3 CRC-Card kelas ketua_G 

Ketua_G 

Responsibility Collaboration 

Mengelola anggota Anggota_G 

Mengelola peta Peta 

Mengelola kepala desa Kades 

Mengelola kepala KPH Kepala_KPH 

 
Tabel 3. 4 CRC-Card kelas anggota_G 

Anggota_G 

Responsibility Collaboration 

Melihat ketua gapoktan Ketua_G 

Melihat peta lahan 
garapan 

Peta 

Mengelola pohon Pohon 

Melihat kepala KPH Kepala_KPH 

Melihat kepala desa Kades  

 
Tabel 3. 5 CRC-Card kelas peta 

Peta 

Responsibility Collaboration 

Menampilkan peta lahan 
garapan 

Ketua_G, Anggota_G, 
Kades, dan 
Kepala_KPH Menampilkan lokasi saat 

ini 

Tabel 3. 6 CRC-Card kelas pohon 

Pohon 

Responsibility Collaboration 

Menampilkan nama 
pohon 

Ketua_G, Anggota_G, 
Kades, dan Kepala_KPH 

Menampilkan jumlah 
pohon 

Tabel 3. 7 CRC-Card kelas kades 

Kades 

Responsibility Collaboration 

Melihat peta lahan 
garapan 

Peta 

Melihat anggota Anggota_G 

Melihat ketua gapoktan Ketua_G 

 
Tabel 3. 8 CRC-Card kelas kph 

Kepala_KPH 

Responsibility Collaboration 

Melihat peta lahan 
garapan 

Peta 

Melihat anggota Anggota_G 

Melihat ketua gapoktan Ketua_G 

 
2. Use Case Diagram 

 
Gambar 3. 2 Use Case Diagram 

 
3. Entity Relationship Diagram 

 
Gambar 3. 3 Entity Relationship Diagram 

3.2.9.  Sitemap 
Desain sitemap sistem sangat perlu dilakukan 

sebagai panduan dalam pengenalan alur sistem. 
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Berikut sitemap Sistem Informasi Geografis Pemetaan 
Lahan Garapan Kelompok Tani pada Hutan 
Kemasyarakatan Desa Karang Sidemen. 

 
Gambar 3. 4 Sitemap fitur Ketua Gapoktan 

 
Gambar 3. 5 Sitemap fitur Anggota Gapoktan 

 
Gambar 3. 6 Sitemap fitur Kepala Desa 

 
Gambar 3. 7 Sitemap fitur Kepala KPH 

3.2.10. Coding 
Setelah pembuatan desain sistem, selanjutnya 

pembuatan aplikasi secara utuh. Sistem dibangun 
menggunakan Bahasa java. Sedangkan Firebase untuk 
pengelolaan data pada database. Peta geografi secara 
keseluruhan akan menggunakan peta dari google maps 
API. 
3.2.11. Testing 

Tahap pengujian sistem merupakan tahapan 
uji sistem yang dibangun sesuai dengan tahapan 
sebelumnya.  

User Acceptance Test (UAT) merupakan 
metode pengujian aplikasi terhadap pengguna (end 
user)[24]. 

Menurut Perry, UAT adalah metode pengujian 
sistem yang dibangun dan dilakukan oleh pengguna 
dari sistem itu sendiri serta dilakukan verifikasi 
terhadap semua fungsi sistem sudah sesuai dengan 
kebutuhan[25]. 

 
Tabel 3. 9 User Acceptance Test 

No Pengujian SIG Pemetaan 
Lahan Garapan Kelompok 

Tani pada HKm Desa Karang 
Sidemen 

Hasil 

1 

Nama uji: 
Deskripsi pengujian: 
Kasus uji: 
Hasil yang diharapkan: 

Berhasil/Gagal 

 
Kemudian jawaban kuesioner dilakukan 

perhitungan untuk mendapatkan kesimpulan apakah 
sistem dapat diterima atau tidak menggunakan teori 
penskalaan Guttman. 
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4. HASIL DAN PEMBAHASAN 
 

4.1. Pengkodean 
Setelah melakukan perancangan sistem, 

selanjutnya akan dilakukan pembuatan (pengkodean) 
program sehingga menghasilkan sistem secara utuh 
yang dapat digunakan sesuai fungsi yang diinginkan. 
Pembahasan pada tahapan ini meliputi pembuatan 
database, pembuatan tampilan sistem, dan 
pembuatan fungsi sistem. 
4.1.1. Pesiapan sistem 

User permission merupakan izin sistem yang 
dibangun harus dibuat agar aplikasi dapat beroperasi 
dengan baik. 

 
Gambar 4. 6 User Permission 

4.1.2. Pembuatan database 

 
Gambar 4. 7 Database sistem 

4.1.3. Implementasi tampilan sistem 
Tampilan sistem merupakan interface yang 

berinteraksi langsung dengan pengguna sistem. 
Pembuatan tampilan sistem didasarkan pada 
rancangan sebelumnya dan memiliki 4 jenis pengguna, 
yaitu Ketua Gapoktan, Anggota Gapoktan, Kepala Desa, 
dan Kepala KPH. 

 
4.1.1.1. Ketua Gapoktan 

 
Gambar 4. 8 Tampilan pilihan pengguna 

 

 
Gambar 4. 9 Tampilan login ketua 

 
Gambar 4. 10 Tampilan home ketua 

 

 
Gambar 4. 11 Tampilan peta 

 
Gambar 4. 12 Tampilan detail anggota 
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Gambar 4. 13 Tampilan detail lahan 

 

 
Gambar 4. 14 Tampilan tambah anggota 

 

 
Gambar 4. 15 Proses tambah anggota 

 
Gambar 4. 16 Tampilan tambah lahan 

 
Gambar 4. 17 Proses tambah lahan 

 

 
Gambar 4. 18 Tampilan tambah koordinat 

 

 
Gambar 4. 19 Proses tambah koordinat 

 

 
Gambar 4. 20 Tampilan edit anggota 
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Gambar 4. 21 Proses edit anggota 

 
4.1.1.2. Anggota Gapoktan 

 
Gambar 4. 22 Tampilan home anggota 

 

 
Gambar 4. 23 Tampilan tambah pohon 

 
Gambar 4. 24 Tampilan edit pohon 

4.1.1.3. Kepala Desa 

 
Gambar 4. 25 Tampilan home kades 

4.1.1.4. Kepala KPH 

 
Gambar 4. 26 Tampilan home kph 

4.2. Pengujian  
Pengujian penerimaan pengguna dilakukan 

menggunakan metode User Acceptance Test (UAT) 
dalam bentuk kuisioner kepada ketua gapoktan 
sebanyak 1 orang, anggota gapoktan sebanyak 10 
orang, kepala desa sebanyak 1 orang, dan kepala kph 
sebanyak 1 orang 

Setelah didapatkan hasil kuisioner kemudian 
dihitung dengan metode Guttman untuk mendapatkan 
kesimpulan bahwa sistem dapat diterima oleh 
Gapoktan Desa Karang Sidemen. 

Hasil pengujian fitur ketua gapoktan didapatkan 
nilai koefisien skalabilitas sebesar 1, fitur anggota 
gapoktan didapatkan nilai koefisien skalabilitas sebesar 
0.82, fitur kepala desa didapatkan nilai koefisien 
skalabilitas sebesar 1, dan fitur kepala kph didapatkan 
nilai koefisien skalabilitas sebesar 1 sehingga memiliki 
kesimpulan baik atau diterima. 

 
4.3. Sistem yang dihasilkan 

Sistem yang dihasilkan dapat menampilkan lahan 
setiap anggota secara akurat karena pengambilan data 
lahan dilakukan menggunakan alat GPS tracker oleh 
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petugas yang berwenang dan telah menggunakan 
google maps API. 

Sistem digunakan sebagai alat monitoring lahan 
garapan petani yang meliputi batas-batas lahan, lokasi 
lahan, tanaman produksi yang siap panen sehingga 
petugas terkait dapat melakukan sebuah tindakan 
ataupun perencanaan untuk kesejahteraan anggota 
gapoktan Wana Lestari. 
 

5. KESIMPULAN DAN SARAN 
 
5.1. Kesimpulan 

Berdasarkan hasil perancangan “Sistem 
Informasi Geografis Pemetaan Lahan Garapan 
Kelompok Tani Pada Hutan Kemasyarakatan Desa 
Karang Sidemen Berbasis Mobile” yang dilakukan, 
dapat ditarik beberapa kesimpulan: 
1. Pengumpulan data pribadi petani dilakukan dengan 

cara wawancara langsung kepada petani. 
Sedangkan untuk mendapatkan data lahan petani 
secara valid dilakukan pengukuran secara langsung 
menggunakan bantuan alat Global Positioning 
System (GPS) dan Software ArcGIS sebagai alat 
pengolahan data yang diperoleh.  

2. Pembangunan SIG dilakukan dengan bantuan 3 alat 
yang paling mendasar yaitu: 

a.  Global Positioning System (GPS) 
Alat GPS digunakan dalam pengukuran lahan karena 

dapat membaca dan menyimpan koordinat secara real-
time dan kemudian menjadi sebuah peta lahan dalam 
bentuk poligon. Namun koordinat yang dihasilkan 
biasanya memiliki error kurang lebih 1-10 Meter dari 
koordinat asli, sehingga membutuhkan bantuan 
software ArcGIS.  
b. Software ArcGIS 

Software ArcGIS digunakan dalam pengolahan data 
mentahan yang didapatkan dari GPS. Pengolahan 
menggunakan software ArcGIS menghasilkan data 
lahan yang sesuai dengan koordinat asli dan disertai 
dengan luas lahan. 
c. Software Android Studio 

Software Android Studio digunakan untuk 
perancangan SIG berbasis mobile sehingga 
menghasilkan aplikasi mobile secara utuh. 
3. Pengguna sistem dapat melihat informasi lahan 

garapan setiap anggota yang terdaftar sebagai 
Anggota Gapoktan Wana Lestari (Gapoktan HKm 
Desa Karang Sidemen) yang meliputi lokasi lahan 
dalam bentuk koordinat, luas lahan dengan satuan 
hektar (Ha), batas lahan setiap petani, data anggota, 
dan data tanaman produksi yang terdapat pada 
setiap lahan petani. 

4. Menggunakan SIG berbasis mobile dalam 
memonitoring HKm Desa Karang Sidemen dirasa 
sudah efektif dikarenakan pada sistem yang telah 
dibangun terdapat berbagai informasi yang 
perlukan secara cepat dan tepat oleh Gapoktan 
Desa Karang Sidemen dan KPH Pelangan Tastura. 
Selain itu juga, sebagian besar Anggota Gapoktan 
Wana Lestari sudah menggunakan smartphone dan 
internet sehingga mempercepat pendistribusian 
informasi lahan garapan masing-masing. 

 
5.2. Saran  

Setelah melakukan penelitian, beberapa saran yang 
penulis berikan guna kemajuan dan perbaikan sistem 
informasi, antara lain: 
1. Untuk penelitian selanjutnya, peneliti dapat 

mengembangkan sistem yang dapat dilihat oleh 
masyarakat umum dan berbasis online agar lebih 
memudahkan warga umum mengetahui informasi 
tanaman beserta hasil panen yang ada di HKm desa 
Karang Sidemen untuk menunjang ekonomi petani. 

2. Untuk penelitian selanjutnya, peneliti dapat 
mengembangkan sistem dalam bentuk website 
yang terintegrasi dengan sistem berbasis mobile 
agar menarik lebih banyak orang menggunakan 
sistem informasi geografis HKm Desa Karang 
Sidemen. 

3. Untuk penelitian selanjutnya, pengujian sistem 
diharapkan lebih menyeluruh lagi agar 
menghasilkan sistem yang dihasilkan memiliki 
tampilan dan fitur yang sesuai dengan kebutuhan. 

4. Untuk penelitian selanjutnya dapat ditambahkan 
fitur sesuai kebutuhan pada saat penelitian 
dilakukan. 
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